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New Installation (Microsoft Access)  
 
Upgrading? If you are upgrading or installing a free update, do not proceed, see the Upgrading 
Instructions. 

Step 1 - Download & Extract the PDshop .Net Zip file 
Download the zip file that contains the PDshop .Net scripts/files, ex."pdshopnet.zip".  Save it to your 
computer, or web server.  Using your Unzip program or Computer's built in Extract Tool, locate the file 
you just saved, and extract all files and folders contained within it to your computer.  Make note of the 
location you are saving to. 
 

Step 2 - Determine Database Location 
PDshop .Net is database driven , so unlike HTML pages which never change, .aspx pages are dynamic, the 
content/text is stored in a database and each time the page is requested the script retrieves the 
appropriate data from the database.  PDshop .Net comes with a preconfigured Microsoft Access database 
(compatible with MSAccess 2000/2003/XP).   
 
First, locate the files you just extracted in Step 1.  Find the "data" folder.  In the database folder  you will 
find the Access database file, for example "somefile.mdb".  This is the database file you will be uploading 
shortly.  If you are planning on uploading the database to your "web root", it is strongly recommended 
that you rename the "data" directory.  Change the name of this folder to something only you would know.  
It should be noted that most web hosts provide a special database folder (that is not located in the web 
root).  Take a moment and determine where you are going to upload the database file to (on your server).  
Make note of the location for the next step. 
 

Step 3 - Edit your 'web.config' file 
The "web.config" file is the standardized ASP.NET configuration file used to define a series of important 
constants.  It will be used to tell PDshop .Net basic information such as where your database is and what 
driver to use when connecting to it, etc. 
 
Locate the "web.config" file on your computer (it's one of the files you unzipped earlier in Step 1). Using 
Microsoft's "Notepad", usually found under "Program Files>Accessories", you can open this file and make 
changes.  The first thing you will need to change in this file is the location (aka path) to the database.  
You must update the web.config file to reflect the location you choose or folder name you chose in Step 2.  
For convenience, PDshop .Net has some simple "keys" you can use to quickly specify the path (so you 
don't need to edit or write complex connection strings).   
 
If you plan to upload the database folder into your web root, you can simply change the virtual path listed 
in the default "dbvirtualpath" key.  For Example, look for this in your web.config file:  
 
<add key="dbvirtualpath" value="../data/somefile.mdb" /> 
 
In that example, you would change "/data/" to whatever you named your data folder.   If you renamed 
your data folder to "mydb", you would want to change the "value" as follows:  
 
<add key="dbvirtualpath" value="../mydb/somefile.mdb" /> 
 
OTHER CONNECTION/DRIVER SCENARIOS:  
If you plan on uploading the database into a location on your server that is not your "web root", such as a 
special folder your host provides that is only accessible by FTP, you can substitute the "dbvirtualpath" key 
with the "dbphysicalpath" key.  Locate the "web.config_examples.txt" file on your computer (same 
location as the web.config).  You will see this key (and others) that you can easily include in your 
web.config to connect with your database.   
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Simply modify, then copy, the appropriate key(s) into your web.config file (be sure to put your key(s) in 
the "appSettings" section of the web.config file).  For example, remove the "dbvirtualpath" key from your 
web.config, then copy & paste the "dbphysicalpath" key, replacing the value in it with the physical location 
to your database folder (you may need to ask your host what the path is).   
 
For example:  <add key="dbphysicalpath" value="C:\inetpub\wwwroot\data\somefile.mdb" /> 
Both the the dbvirtualpath & dbphysicalpath keys will automatically connect to the database using the 
server's built-in OLEDB drivers.  In some cases you may want or need to use a different driver, or connect 
using a DSN.  In those cases, you can add additional keys to the web.config.  See the Web.config Guide or 
the "web.config_examples.txt" file for more options & examples.   
 
UNSURE HOW TO EDIT THIS FILE? 
If you are using a web hosting service, your web host should provide some basic "path" information or 
sample connection strings, see their support pages for examples.  If you are unsure how to edit the 
"web.config" file, PageDown Technology does offer an installation service.  Let our team configure, and 
upload PDshop .Net to your web server (see our website for more details, 
http://www.pagedowntech.com/shop/)  
 

Step 4 - Rename your "admin" folder, and update the web.config (optional) 
It is recommended that you change the name of the "admin" folder.  The admin folder is where PDAdmin, 
the web based administrator, is located.  Locate the "admin" directory on your computer, and rename this 
folder to something else.  Next, you will need to modify the "pdadminfolder" key in the web.config file.   
 
Change the value of this key from the default "admin" to whatever you renamed your admin folder to.  For 
example, if you renamed the admin folder to "myadmin" that key should look like: 
 
<add key="pdadminfolder" value="myadmin" /> 
 

Step 5 - Change the default Encryption Password (optional) 
The encryption code key in the web.config (called "cryptpass"), is the "password" used to encrypt and 
decrypt sensitive data that is stored in the PDshop .Net database. If you do not wish to use the default 
encryption code, you must change it before you begin using the online store, it cannot be changed once 
passwords, or credit card data has been stored in the database. This key must be kept short, less than 10 
characters, or the performance of your server may be compromised.   
 

Step 6 - Upload the Folders & Files 
Now it's time to upload the PDshop .Net files and database to your web server.   
 
Using your FTP software, login to your web server and navigate to the location you determined you will 
put your database (in Step 2).  Find and upload the database file from your computer to your web server. 
 
Next, navigate to your "web root" on your server, the primary folder on the server where your html/aspx 
files are loaded. For example, many web hosts name the web root folder "wwwroot" or "html" or "www" or 
"web", etc.  Upload the remaining PDshop .Net files and folders to your server, be sure to keep the 
PDshop .Net files in their original folders (as they are on your computer).  After uploading, your directory 
structure should look something like this: 
 
The web.config and default.aspx file should be located at the web root:` 
/wwwroot/web.config 
/wwwroot/default.aspx 
 
And the rest of the folders should appear like so: 
/wwwroot/youradmin/ 
/wwwroot/bin/ 
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/wwwroot/shop/ 
etc. 
 
NOTES: if your FTP root and www root are the same, than you would not see the "wwwroot", and it would 
look like this: 
web.config 
default.aspx 
/youradmin/ 
/bin/ 
/shop/ 
 

Step 7 - Check/Set Database & Folder Permissions 
Using your web host's control panel, you will need to set or check the "permissions" (security settings) on 
your web server.  If your web host does not provide these settings, you may need to contact them for 
these important security changes (this is a common request, your web host should have no problem with 
adjusting these settings for you). 
 
Your database file must have at least "Write" permission, so that the server allows PDshop .Net to 
save/update the database. If you wish to use the PDshop .Net Image upload functions (for uploading 
images), you must also set "Write" permission on the "images" directory.  
 
If you wish to use the export feature, you must create or upload the "export" folder and establish "Write" 
permissions.  
 
Note: Always consult with your web host or server administrator before making any security related 
changes.   
 

Testing PDshop  
Using your web browser, navigate to the shop folder, for example you might type 
“http://www.yourdomain.com/shop/” into the address bar.  Remember to substitute “yourdomain.com”  
with your actual domain name.  Upon reaching the storefront, you should see the PDshop default home 
page.  Next, search for an item (PDshop comes with a built in test item), click the "Buy Now" button while 
viewing an item to add it to your shopping cart.  If the item is added to your shopping cart, than you have 
successfully installed PDshop.  You are ready to proceed to the web based Administrator.   
 

Initializing the Admin 
Using Internet Explorer (version 5 or higher), navigate to where your Admin is located to begin the initial 
setup of your Admin.  For example, you might type “http://www.yourdomain.com/admin/” into the 
address bar to reach your Admin.  Remember to substitute “admin” in that URL with the name of your 
admin folder.   Upon entering the Admin for the first time you will need to enter the URL/Domain Name, 
setup/create Admin Users, and finally Activate PDshop.   
 
See the “Initializing the Admin” section of this Guide for detailed steps and more information.  
 
If you receive an "PDshop Error" message, or are unable to see the storefront while trying to access the 
store or PDAdmin, see the “Troubleshooting” sections in this guide.  
 

Security Best Practices 
After you have successfully installed and activated your copy of PDshop, you should review the “Best 
Practices” security section in this guide. 
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New Installation (Microsoft SQL Server) 
  
Upgrading? If you are upgrading or installing a free update, do not proceed, see the Upgrading 
Instructions. 

Step 1 - Download & Extract the PDshop .Net Zip file 
Download the zip file that contains the PDshop .Net scripts/files, ex."pdshopnet.zip".  Save it to your 
computer, or web server.  Using your Unzip program or Computer's built in Extract Tool, locate the file 
you just saved, and extract all files and folders contained within it to your computer.  Make note of the 
location you are saving to. 
 

Step 2 - Create a New/Blank Database 
PDshop .Net is database driven , so unlike HTML pages which never change, .aspx pages are dynamic, the 
content/text is stored in a database and each time the page is requested the script retrieves the 
appropriate data from the database.   
 
The first step is to create a new, completely blank, MSSQL database.  Contact your web host or server 
administrator for this procedure.  Creating a blank database can be done using your SQL "Enterprise 
Manager", or in many cases, your web hosts control panel.  Take a moment and note (for the next step) 
the database Name, Server Location/IP, and Login details.   
 

Step 3 - Edit your 'web.config' file 
The "web.config" file is the configuration file used to define a series of important constants, it tells PDshop 
.Net basic information such as where your database is and what driver to use when connecting to it, etc.   
 
Locate the "web.config" file on your computer (it's one of  the files you unzipped earlier in Step 1). Using 
Microsoft's "Notepad", usually found under "Program Files>Accessories", you can open this file and make 
changes.  The first thing you will need to do is remove the default "dbvirtualpath" key, and insert new 
keys that will define the database location.  PDshop.net has 3 keys you will need to define, dbtype 
(MSAccess/MSSQL), dbconntype (which driver type), and dbconn (the connection string).   
 
Here is an example of what you would need to add: 
 
Using the Server's OLEDB Driver: 
 
<add key="dbtype" value="MSSQL" /> 
<add key="dbconntype" value="OLEDB" /> 
<add key="dbconn" value="Provider=SQLOLEDB;Data Source=servername;Initial Catalog=database;User 
Id=user;Password=password;" /> 
 
Using the Server's ODBC Driver: 
 
<add key="dbtype" value="MSSQL" /> 
<add key="dbconntype" value="ODBC" /> 
<add key="dbconn" value="DRIVER={SQL 
Server};SERVER=servername;UID=user;PWD=password;DATABASE=database" /> 
 
OTHER CONNECTION/DRIVER SCENARIOS:  
In some cases you may want or need to use a different driver, or connect using a DSN.  In those cases, 
you can add additional keys to the web.config.  See the Web.config Guide for more options.   
 
UNSURE HOW TO EDIT THIS FILE? 
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If you are using a web hosting service, your web host should provide some basic database information or 
sample connection strings, see their support pages for examples.  If you are unsure how to edit the 
"web.config" file, PageDown Technology does offer an installation service.  Let our team configure, and 
upload PDshop .Net to your web server (see our website for more details, 
http://www.pagedowntech.com/shop/)  
 

Step 4 - Rename your "admin" folder, and update the web.config (optional) 
It is recommended that you change the name of the "admin" folder.  The admin folder is where PDAdmin, 
the web based administrator, is located.  Locate the "admin" directory on your computer, and rename this 
folder to something else.  Next, you will need to modify the "pdadminfolder" key in the web.config file.   
 
Change the value of this key from the default "admin" to whatever you renamed your admin folder to.  For 
example, if you renamed the admin folder to "myadmin" that key should look like: 
 
<add key="pdadminfolder" value="myadmin" /> 
 

Step 5 - Change the default Encryption Password (optional) 
The encryption code key in the web.config (called "cryptpass"), is the "password" used to encrypt and 
decrypt sensitive data that is stored in the PDshop .Net database. If you do not wish to use the default 
encryption code, you must change it before you begin using the online store, it cannot be changed once 
passwords, or credit card data has been stored in the database. This key must be kept short, less than 10 
characters, or the performance of your server may be compromised.   
 

Step 6 - Upload the Folders & Files 
Now it's time to upload the PDshop .Net files to your web server.   
 
Using your FTP software, login to your web server and navigate to your "web root" on your server, the 
primary folder on the server where your html/aspx files are loaded. For example, many web hosts name 
the web root folder "wwwroot" or "html" or "www" or "web", etc.  Upload the PDshop .Net files and folders 
to your server, be sure to keep the PDshop .Net files in their original folders (as they are on your 
computer).  After uploading, your directory structure should look something like this: 
 
The web.config and default.aspx file should be located at the web root: 
/wwwroot/web.config 
/wwwroot/default.aspx 
 
And the rest of the folders should appear like so: 
/wwwroot/youradmin/ 
/wwwroot/bin/ 
/wwwroot/shop/ 
etc. 
 
NOTES: if your FTP root and www root are the same, than you would not see the "wwwroot", and it would 
look like this: 
web.config 
default.aspx 
/youradmin/ 
/bin/ 
/shop/ 
 

Step 7 - Formatting the MSSQL Database 
Using your web browser, the next step is to run the database format procedure, which will add the 
necessary tables, columns (fields), and default data to your new database.  Using your web browser, 
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navigate to the "dbsetup.aspx" page in your "admin" directory on your server.  For example: 
http://www.yourdomainname.com/admin/dbsetup.aspx.   
(replace "admin" with then name of your admin folder) 
 
Next, see the "Format/Upgrade Database" heading and click the "Begin Format" button.  This procedure 
will not create the database, it will only add the tables, columns (fields),  and default data.  Make sure you 
have created a new/blank database first (see above). 
 

Step 8 - Check/Set Folder Permissions 
Using your web host's control panel, you will need to set or check the "permissions" (security settings) on 
your web server.  If your web host does not provide these settings, you may need to contact them for 
these important security changes (this is a common request, your web host should have no problem with 
adjusting these settings for you). 
 
If you wish to use the PDshop .Net Image upload functions (for uploading images), you must set "Write" 
permission on the "images" directory.  
 
If you wish to use the export feature, you must create or upload the "export" folder and establish "Write" 
permissions.  
 
Note: Always consult with your web host or server administrator before making any security related 
changes.   
 

Testing PDshop  
Using your web browser, navigate to the shop folder, for example you might type 
“http://www.yourdomain.com/shop/” into the address bar.  Remember to substitute “yourdomain.com”  
with your actual domain name.  Upon reaching the storefront, you should see the PDshop default home 
page.  Next, search for an item (PDshop comes with a built in test item), click the "Buy Now" button while 
viewing an item to add it to your shopping cart.  If the item is added to your shopping cart, than you have 
successfully installed PDshop.  You are ready to proceed to the web based Administrator.   
 

Initializing the Admin 
Using Internet Explorer (version 5 or higher), navigate to where your Admin is located to begin the initial 
setup of your Admin.  For example, you might type “http://www.yourdomain.com/admin/” into the 
address bar to reach your Admin.  Remember to substitute “admin” in that URL with the name of your 
admin folder.   Upon entering the Admin for the first time you will need to enter the URL/Domain Name, 
setup/create Admin Users, and finally Activate PDshop.   
 
See the “Initializing the Admin” section of this Guide for detailed steps and more information.  
 
If you receive an "PDshop Error" message, or are unable to see the storefront while trying to access the 
store or PDAdmin, see the “Troubleshooting” sections in this guide.  
 

Security Best Practices 
After you have successfully installed and activated your copy of PDshop, you should review the “Best 
Practices” security section in this guide. 
 



 10

Upgrade from “Classic ASP” (Microsoft Access) 
  
Guide for upgrading from PDshop Pro, Standard, Plus, or Advanced to a .NET Edition of PDshop. 
  
This Guide is for use only when upgrading from an ASP version, such as PDshopPro, Standard, Plus, or 
Advanced.   
 

Backup Existing site 

Before uploading any PDshop .Net files, you must make a backup of your existing PDshop files and 
database. You can do this with your FTP software by downloading the old files to a safe location on your 
local computer. We highly recommend this! This way, if anything unforeseen happens, you can simply re-
upload the original files and database. Our free technical support does not include data recovery or cover 
some severe problems encountered by an update/upgrade mishap. 
 

Step 1 - Download & Extract the PDshop .Net Zip file 
Download the zip file that contains the PDshop .Net scripts/files, ex."pdshopnet.zip".  Save it to your 
computer, or web server.  Using your Unzip program or Computer's built in Extract Tool, locate the file 
you just saved, and extract all files and folders contained within it to your computer.  Make note of the 
location you are saving to. 
 

Step 2 - Determine Database Location 
Using your old "setup.asp" file (from your server's "includes" directory), make note of the location of your 
current PDshop database for the next step.  You will need to copy the database name and/or path from 
your old setup.asp file to the new web.config file. 
 

Step 3 - Edit the 'web.config' file 
The "web.config" file is the standardized ASP.NET configuration file used to define a series of important 
constants.  It will be used to tell PDshop .Net basic information such as where your database is and what 
driver to use when connecting to it, etc. 
 
Locate the "web.config" file on your computer (it's one of  the files you unzipped earlier in Step 1). Using 
Microsoft's "Notepad", usually found under "Program Files>Accessories", you can open this file and make 
changes.  The first thing you will need to change in this file is the location (aka path) to the database.  
You must update the web.config file to reflect the location you choose or folder name you chose in Step 2.  
For convenience, PDshop .Net has some simple "keys" you can use to quickly specify the path (so you 
don't need to edit or write complex connection strings).   
 
If you plan to upload the database folder into your web root, you can simply change the virtual path listed 
in the default "dbvirtualpath" key.  For Example, look for this in your web.config file:  
 
<add key="dbvirtualpath" value="../data/somefile.mdb" /> 
 
In that example, you would change "/data/" to whatever you named your data folder.   If you renamed 
your data folder to "mydb", you would want to change the "value" as follows:  
 
<add key="dbvirtualpath" value="../mydb/somefile.mdb" /> 
 
OTHER CONNECTION/DRIVER SCENARIOS:  
If you plan on uploading the database into a location on your server that is not your "web root", such as a 
special folder your host provides that is only accessible by FTP, you can substitute the "dbvirtualpath" key 
with the "dbphysicalpath" key.  Locate the "web.config_examples.txt" file on your computer (same 
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location as the web.config).  You will see this key (and others) that you can easily include in your 
web.config to connect with your database.   
 
Simply modify, then copy, the appropriate key(s) into your web.config file (be sure to put your key(s) in 
the "appSettings" section of the web.config file).  For example, remove the "dbvirtualpath" key from your 
web.config, then copy & paste the "dbphysicalpath" key, replacing the value in it with the physical location 
to your database folder (you may need to ask your host what the path is).   
 
For example:  <add key="dbphysicalpath" value="C:\inetpub\wwwroot\data\somefile.mdb" /> 
Both the the dbvirtualpath & dbphysicalpath keys will automatically connect to the database using the 
server's built-in OLEDB drivers.  In some cases you may want or need to use a different driver, or connect 
using a DSN.  In those cases, you can add additional keys to the web.config.  See the Web.config Guide or 
the "web.config_examples.txt" file  for more options & examples.   
 
UNSURE HOW TO EDIT THIS FILE? 
If you are using a web hosting service, your web host should provide some basic "path" information or 
sample connection strings, see their support pages for examples.  If you are unsure how to edit the 
"web.config" file, PageDown Technology does offer an installation service.  Let our team configure, and 
upload PDshop .Net to your web server (see our website for more details, 
http://www.pagedowntech.com/shop/)  
 

Step 4 - Rename the "admin" folder, and update the web.config (optional) 
It is recommended that you change the name of the "admin" folder.  The admin folder is where PDAdmin, 
the web based administrator, is located.  Locate the "admin" directory on your computer, and rename this 
folder to something else.  Next, you will need to modify the "pdadminfolder" key in the web.config file.   
 
Change the value of this key from the default "admin" to whatever you renamed your admin folder to.  For 
example, if you renamed the admin folder to "myadmin" that key should look like: 
 
<add key="pdadminfolder" value="myadmin" /> 
 

Step 5 - Check/Change the default Encryption Password (if necessary) 
Open your old "setup.asp" file and compare the "rc4code" variable with the encryption code key in the 
new web.config (called "cryptpass").  Make sure the value in the key is the same as your rc4code.   If not, 
you will need to update the web.config with this new value. 
 

Step 6 - Remove/Rename Old Folders & .asp Files 
Using your FTP software, logon to your web server and locate your existing PDshop files & folders.  Look 
for the "admin", "includes", and "shop" folders.  For PDshop .Net to work correctly, you will first need to 
remove or rename the old PDshop folders.  Either remove/delete, or temporarily rename the following 
folders: "admin", "includes", and "shop" to "old-admin", "old-includes", and "old-shop".   
 
(After a successful .Net installation you should permanently remove the "old-" folders). 
 

Step 7 - Upload the New Folders & Files 
Now it's time to upload the PDshop .Net files to your web server.   
 
DATABASE WARNING!!! 
ALL PDshop .NET downloads include the default/blank Microsoft Access database file, it may have the 
same name as your old one!   Do NOT upload the blank database (usually named "pdshoppro.mdb"). 
 
Using your FTP software, navigate to your "web root" on your server, the primary folder on the server 
where your html/aspx files are loaded (where your old shop & admin folders were).  Upload the PDshop 
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.Net files and folders to your server, be sure to keep the PDshop .Net files in their original folders (as they 
are on your computer).  After uploading, your directory structure should look something like this: 
 
The web.config and default.aspx file should be located at the web root: 
/wwwroot/web.config 
/wwwroot/default.aspx 
 
And the rest of the folders should appear like so: 
/wwwroot/youradmin/ 
/wwwroot/bin/ 
/wwwroot/shop/ 
etc. 
 
FTP NOTES:  
If your FTP root and www root are the same, than you would not see the "wwwroot", and it would look like 
this: 
web.config 
default.aspx 
/youradmin/ 
/bin/ 
/shop/ 
 
BIN FOLDER NOTES:  
If you have chosen to install PDshop in a subdirectory, for example, your admin is at 
http://yoursite.com/somefolder/admin, be sure you upload the "Bin" directory to the web root.  Microsoft 
web servers will only recognize "Bin" directories if they located in the application root. 
 

Step 8 - Upgrading the Database 
Using your web browser, the next step is to run the database format procedure, which will add the 
necessary tables, columns (fields), and default data to your existing database.  Using your web browser, 
navigate to the "dbsetup.aspx" page in your "admin" directory on your server.  For example: 
http://www.yourdomainname.com/admin/dbsetup.aspx.   
(replace "admin" in this URL with the name of your admin folder) 
 
See the "Format/Upgrade Database" heading and below it fill in your PDAdmin username & password, 
then click the "Begin Format" button.   
 
PDshop "Standard" Edition Users: 
If you are upgrading from the "Standard" Edition, you will also want to run the "Upgrade v2.0 Data" 
procedure which will adapt some of your existing data to the .Net format. This process updates/moves 
data into some of the new fields and tables, and must be run after the "Format/Upgrade". You MUST 
backup your database first before trying to run this procedure! Do not run this script more than once, as it 
may produce duplicate records in your database. Plus and Advanced users should NOT run this step. 
 

Step 9 - Check/Set Folder Permissions 
Using your web host's control panel, you will need to set or check the "permissions" (security settings) on 
your web server.  If your web host does not provide these settings, you may need to contact them for 
these important security changes (this is a common request, your web host should have no problem with 
adjusting these settings for you). 
 
If you wish to use the PDshop .Net Image upload functions (for uploading images), you must set "Write" 
permission on the "images" directory.  
 
If you wish to use the export feature, you must create or upload the "export" folder and establish "Write" 
permissions.  
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Note: Always consult with your web host or server administrator before making any security related 
changes.   
 

Testing PDshop  
Using your web browser, navigate to the shop folder, for example you might type 
“http://www.yourdomain.com/shop/” into the address bar.  Remember to substitute “yourdomain.com”  
with your actual domain name.  Upon reaching the storefront, you should see the PDshop default home 
page.  Next, search for an item (PDshop comes with a built in test item), click the "Buy Now" button while 
viewing an item to add it to your shopping cart.  If the item is added to your shopping cart, than you have 
successfully installed PDshop.  You are ready to proceed to the web based Administrator.   
 

Initializing the Admin 
Using Internet Explorer (version 5 or higher), navigate to where your Admin is located to begin the initial 
setup of your Admin.  For example, you might type “http://www.yourdomain.com/admin/” into the 
address bar to reach your Admin.  Remember to substitute “admin” in that URL with the name of your 
admin folder.   Upon entering the Admin for the first time you will need to enter the URL/Domain Name, 
setup/create Admin Users, and finally Activate PDshop.   
 
See the “Initializing the Admin” section of this Guide for detailed steps and more information.  
 
If you receive an "PDshop Error" message, or are unable to see the storefront while trying to access the 
store or PDAdmin, see the “Troubleshooting” sections in this guide.  
 

Security Best Practices 
After you have successfully installed and activated your copy of PDshop, you should review the “Best 
Practices” security section in this guide. 
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Upgrade from “Classic ASP” (Microsoft SQL Server)  
  
Guide for upgrading from PDshop Pro, Standard, Plus, or Advanced to a .NET Edition of PDshop. 
  
This Guide is for use only when upgrading from an ASP version of PDshop, such as PDshopPro, Standard, 
Plus, or Advanced.   
 
Backup Existing site 
Before uploading any PDshop .Net files, you must make a backup of your existing PDshop files and 
database. You can backup the PDshop files with your FTP software by downloading the old files to a safe 
location on your local computer.  To backup your database you will need to contact your web host for their 
procedures.  We highly recommend making backups, this way, if anything unforeseen happens, you can 
simply re-upload the original files and restore your database. Our free technical support does not include 
data recovery or cover some severe problems encountered by an update/upgrade mishap. 
 

Step 1 - Download & Extract the PDshop .Net Zip file 
Download the zip file that contains the PDshop .Net scripts/files, ex."pdshopnet.zip".  Save it to your 
computer, or web server.  Using your Unzip program or Computer's built in Extract Tool, locate the file 
you just saved, and extract all files and folders contained within it to your computer.  Make note of the 
location you are saving to. 
 

Step 2 - Determine Database Location 
Using your old "setup.asp" file (from your server's "includes" directory), make note of the database driver 
used, database & server names, as well as Login details.  You will need to copy the connection string 
(from the "dbconn" variable) from your old setup.asp file to the new web.config file.   
 

Step 3 - Edit the 'web.config' file 
The "web.config" file is the configuration file used to define a series of important constants, it tells PDshop 
.Net basic information such as where your database is and what driver to use when connecting to it, etc.   
 
Locate the "web.config" file on your computer (it's one of  the files you unzipped earlier in Step 1). Using 
Microsoft's "Notepad", usually found under "Program Files>Accessories", you can open this file and make 
changes.  The first thing you will need to do is remove the default "dbvirtualpath" key, and insert new 
keys that will define the database location.  PDshop.net has 3 keys you will need to define, dbtype 
(MSAccess/MSSQL), dbconntype (which driver type), and dbconn (the connection string).   
 
Here is an example of what you would need to add: 
 
Using the Server's OLEDB Driver: 
 
<add key="dbtype" value="MSSQL" /> 
<add key="dbconntype" value="OLEDB" /> 
<add key="dbconn" value="Provider=SQLOLEDB;Data Source=servername;Initial Catalog=database;User 
Id=sa;Password=password;" /> 
 
Using the Server's ODBC Driver: 
 
<add key="dbtype" value="MSSQL" /> 
<add key="dbconntype" value="ODBC" /> 
<add key="dbconn" value="DRIVER={SQL 
Server};SERVER=servername;UID=sa;PWD=password;DATABASE=database" /> 
OTHER CONNECTION/DRIVER SCENARIOS:  
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In some cases you may want or need to use a different driver, or connect using a DSN.  In those cases, 
you can add additional keys to the web.config.  See the Web.config Guide for more options.   
 
UNSURE HOW TO EDIT THIS FILE? 
If you are using a web hosting service, your web host should provide some basic database information or 
sample connection strings, see their support pages for examples.  If you are unsure how to edit the 
"web.config" file, PageDown Technology does offer an installation service.  Let our team configure, and 
upload PDshop .Net to your web server (see our website for more details, 
http://www.pagedowntech.com/shop/)  
 

Step 4 - Rename the "admin" folder, and update the web.config (optional) 
It is recommended that you change the name of the "admin" folder.  The admin folder is where PDAdmin, 
the web based administrator, is located.  Locate the "admin" directory on your computer, and rename this 
folder to something else.  Next, you will need to modify the "pdadminfolder" key in the web.config file.   
 
Change the value of this key from the default "admin" to whatever you renamed your admin folder to.  For 
example, if you renamed the admin folder to "myadmin" that key should look like: 
 
<add key="pdadminfolder" value="myadmin" /> 
 

Step 5 - Check/Change the default Encryption Password (if necessary) 
Open your old "setup.asp" file and compare the "rc4code" variable with the encryption code key in the 
new web.config (called "cryptpass").  Make sure the value in the key is the same as your rc4code.   If not, 
you will need to update the web.config with this new value. 
 

Step 6 - Remove/Rename Old Folders & .asp Files 
Using your FTP software, logon to your web server and locate your existing PDshop files & folders.  Look 
for the "admin", "includes", and "shop" folders.  For PDshop .Net to work correctly, you will first need to 
remove or rename the old PDshop folders.  Either remove/delete, or temporarily rename the following 
folders: "admin", "includes", and "shop" to "old-admin", "old-includes", and "old-shop".   
 
(After a successful .Net installation you should permanently remove the "old-" folders). 
 

Step 7 - Upload the New Folders & Files 
Now it's time to upload the PDshop .Net files to your web server.   
 
Using your FTP software, navigate to your "web root" on your server, the primary folder on the server 
where your html/aspx files are loaded (where your old shop & admin folders were).  Upload the PDshop 
.Net files and folders to your server, be sure to keep the PDshop .Net files in their original folders (as they 
are on your computer).  You do not need to upload the default "data" folder, this is not used with MSSQL 
installations.  After uploading, your directory structure should look something like this: 
 
The web.config and default.aspx file should be located at the web root: 
/wwwroot/web.config 
/wwwroot/default.aspx 
 
And the rest of the folders should appear like so: 
/wwwroot/youradmin/ 
/wwwroot/bin/ 
/wwwroot/shop/ 
etc. 
 
FTP NOTES:  
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If your FTP root and www root are the same, than you would not see the "wwwroot", and it would look like 
this: 
web.config 
default.aspx 
/youradmin/ 
/bin/ 
/shop/ 
 
BIN FOLDER NOTES:  
If you have chosen to install PDshop in a subdirectory, for example, your admin is at 
http://yoursite.com/somefolder/admin, be sure you upload the "Bin" directory to the web root.  Microsoft 
web servers will only recognize "Bin" directories if they are located in the application root. 
 

Step 8 - Upgrading the Database 
Using your web browser, the next step is to run the database format procedure, which will add the 
necessary tables, columns (fields), and default data to your existing database.  Using your web browser, 
navigate to the "dbsetup.aspx" page in your "admin" directory on your server.  For example: 
http://www.yourdomainname.com/admin/dbsetup.aspx.   
(replace "admin" in this URL with the name of your admin folder) 
 
See the "Format/Upgrade Database" heading and below it fill in your PDAdmin username & password, 
then click the "Begin Format" button.   
 
PDshop "Standard" Edition Users: 
If you are upgrading from the "Standard" Edition, you will also want to run the "Upgrade v2.0 Data" 
procedure which will adapt some of your existing data to the .Net format. This process updates/moves 
data into some of the new fields and tables, and must be run after the "Format/Upgrade". You MUST 
backup your database first before trying to run this procedure! Do not run this script more than once, as it 
may produce duplicate records in your database. "Plus" and "Advanced" edition users should NOT run this 
step. 
 

Step 9 - Check/Set Folder Permissions 
Using your web host's control panel, you will need to set or check the "permissions" (security settings) on 
your web server.  If your web host does not provide these settings, you may need to contact them for 
these important security changes (this is a common request, your web host should have no problem with 
adjusting these settings for you). 
 
If you wish to use the PDshop .Net Image upload functions (for uploading images), you must set "Write" 
permission on the "images" directory.  
 
If you wish to use the export feature, you must create or upload the "export" folder and establish "Write" 
permissions.  
 
Note: Always consult with your web host or server administrator before making any security related 
changes.   
 

Testing PDshop  
Using your web browser, navigate to the shop folder, for example you might type 
“http://www.yourdomain.com/shop/” into the address bar.  Remember to substitute “yourdomain.com”  
with your actual domain name.  Upon reaching the storefront, you should see the PDshop default home 
page.  Next, search for an item (PDshop comes with a built in test item), click the "Buy Now" button while 
viewing an item to add it to your shopping cart.  If the item is added to your shopping cart, than you have 
successfully installed PDshop.  You are ready to proceed to the web based Administrator.   
 



 17

Initializing the Admin 
Using Internet Explorer (version 5 or higher), navigate to where your Admin is located to begin the initial 
setup of your Admin.  For example, you might type “http://www.yourdomain.com/admin/” into the 
address bar to reach your Admin.  Remember to substitute “admin” in that URL with the name of your 
admin folder.   Upon entering the Admin for the first time you will need to enter the URL/Domain Name, 
setup/create Admin Users, and finally Activate PDshop.   
 
See the “Initializing the Admin” section of this Guide for detailed steps and more information.  
 
If you receive an "PDshop Error" message, or are unable to see the storefront while trying to access the 
store or PDAdmin, see the “Troubleshooting” sections in this guide. 
 
 

Security Best Practices 
After you have successfully installed and activated your copy of PDshop, you should review the “Best 
Practices” security section in this guide. 
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Update/Upgrade (Existing .Net Edition) 
  
Guide for installing an Update, Revision, or Upgrade.  
 
This Guide is for use only if you already have a .Net (ASP.NET) Edition already installed. 
 

Backup Existing site 

Before uploading any PDshop .Net files, you must make a backup of your existing PDshop files and 
database. You can do this with your FTP software by downloading the old files to a safe location on your 
local computer. We highly recommend this! This way, if anything unforeseen happens, you can simply re-
upload the original files and database. Our free technical support does not include data recovery or cover 
some severe problems encountered by an update/upgrade mishap.   
 
Microsoft SQL Server (MSSQL) Database users: you may need to contact your web host for their 
procedures on backing up your database. 
 

Step 1 - Download & Extract the PDshop .Net Zip file 
Download the zip file that contains the PDshop .Net scripts/files, ex."pdshopnet.zip".  Save it to your 
computer, or web server.  Using your Unzip program or Computer's built in Extract Tool, locate the file 
you just saved, and extract all files and folders contained within it to your computer.  Make note of the 
location you are saving to. 
 

Step 2 - Upload/Replace Files 
Now it's time to upload the PDshop .Net files to your web server.   
 
DATABASE WARNING!!! 
ALL PDshop .NET downloads include the default/blank Microsoft Access database file, it may have the 
same name as your old one!  Do NOT upload the blank database. 
 
Web.Config WARNING!!! 
ALL PDshop .NET downloads include the default web.config.  Do NOT upload the new file, you will be using 
your existing one. 
 
Template Files WARNING!!! 
ALL PDshop .NET downloads include the default HTML templates, named "template.htm", "template-
sub1.htm", etc. If you have customized your templates already, Do NOT upload the new template files. 
 
Using your FTP software, navigate to your existing PDshop folders on your server, locate your "bin", 
"shop", and "admin" folders.  Upload the PDshop .Net files (that you extracted earlier in Step 1), into their 
corresponding folders on your server.  Again, except for the "template" files, web.config, and database 
file, you would typically want to overwrite all the files in your "bin", "shop", and your admin directories.   
 

Step 3 - Upgrading the Database 
Using your web browser, the next step is to run the database format/upgrade procedure, which will add 
any new tables, columns (fields) to your database.  Using your web browser, navigate to the 
"dbsetup.aspx" page in your "admin" directory on your server.  For example: 
http://www.yourdomainname.com/admin/dbsetup.aspx.   
(replace "admin" in this URL with the name of your admin folder) 
 
See the "Format/Upgrade Database" heading and below it fill in your PDAdmin username & password, 
then click the "Begin Format" button.   
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Testing PDshop  
Using your web browser, navigate to the shop folder, for example you might type 
“http://www.yourdomain.com/shop/” into the address bar.  Remember to substitute “yourdomain.com”  
with your actual domain name.  Upon reaching the storefront, you should see the PDshop default home 
page.  Next, search for an item (PDshop comes with a built in test item), click the "Buy Now" button while 
viewing an item to add it to your shopping cart.  If the item is added to your shopping cart, than you have 
successfully installed PDshop.  You are ready to proceed to the web based Administrator.   
 

Initializing the Admin 
Using Internet Explorer (version 5 or higher), navigate to where your Admin is located to begin the initial 
setup of your Admin.  For example, you might type “http://www.yourdomain.com/admin/” into the 
address bar to reach your Admin.  Remember to substitute “admin” in that URL with the name of your 
admin folder.   Upon entering the Admin for the first time you will need to enter the URL/Domain Name, 
setup/create Admin Users, and finally Activate PDshop.   
 
See the “Initializing the Admin” section of this Guide for detailed steps and more information.  
 
If you receive an "PDshop Error" message, or are unable to see the storefront while trying to access the 
store or PDAdmin, see the “Troubleshooting” sections in this guide. 
 
 

Security Best Practices 
After you have successfully installed or updated your copy of PDshop, you should review the “Best 
Practices” security section in this guide. 
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Initializing the Admin 

User Security 
Upon entering the Admin for the first time, you may see a warning message stating that you have not set 
up any users.  We recommend that you create at least one admin user right away.  From the main Admin 
menu, choose User Security under Advanced section.   
 
Press the “Add New User” button to create a new the Admin user.   
 
Username 
The user name should be unique to the User, this should be a single word with no spaces.  For example, if 
your name is John Smith a good username would be “johnsmith” NOT “john”.   
 
Password 
Be sure to create a password that is difficult for someone to guess, this must be a single word with no 
spaces.  It is strongly recommended that you use unique password that you have not used elsewhere, for 
example do not use the same password that you have used with other logins for your web server.   
 
User Level 
There are two types of users, a Level 1 and Level 2.  Level 1 users can access all areas in the Admin, 
whereas a Level 2 user is restricted and cannot access some “Settings” and “Advanced” areas.  
 

URL (Domain Name) 
Under Settings, see “Web Address” or “URL / SSL” to configure the domain name (URL). 

URL 

In the URL field you must enter your regular (non-SSL) URL.  You need to enter the actual URL to where 
the shop is.  For example, http://www.yourdomainname.com/ 
 
The URL you enter in this field must begin with "http://" and must end with "/".  If you are still developing 
the shop, and have a dedicated IP Address you may enter an IP address, see “Development Mode” in this 
guide for more information. 

SSL URL 

See “SSL (Secure Pages)” section further in this documentation.  Setting up an SSL is optional, and can be 
setup at a later time. 
 
Test URL 
It is strongly recommended that you Test the URLs before you save them.  Using the ‘Test’ button located 
to the right of the field, you can see if you entered the correct URL.  When pressed, a new window will 
open and you should see the words “Test Passed” in bold lettering.  If you get a message such as “The 
resource cannot be found”, than the URL you entered is incorrect.  You will need to correct the entry and 
Test again before saving. 
 

Activation 
Once you have entered & tested the URL, you may need to activate PDshop.  Before you activate, some 
Admin & Shop features will not work or will display a “demo mode” message.   
 
NOTE: If you are not ready to activate, see the “Development Mode” below. 
 
To Activate, you will need your PageDown Technology Account number & password.  This is not to be 
confused with your Admin Login. 
 
From the “Home” page in the Admin, click the “Activate” button to begin.  After you enter your Account 
number and Password (the Account number that you received from PageDown Technology when you 
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purchased PDshop), the Admin will verify that you have a valid license and that license will be assigned to 
your URL/Domain.  Because the license is based on your URL, you should not activate the shop until you 
have tested the URL you entered on the URL / SSL settings page.  
 
NOTE: If you need to change the URL in the Admin, this will invalidate the license that you already 
obtained, and may require that you re-activate.  We do NOT recommend changing the URL in the Admin 
once you have activated.  If you do not see an “Activate” button than your shop has already been 
activated or is in Development Mode. 
 

Development  Mode 
If you are not ready to activate, for example your site is not Live yet and you want to setup or test 
without activating it, there is a built in development mode.  By changing the URL in the Admin’s URL 
setup, you can trigger this mode. 
 
The Admin will not require activation if the URL you use meets any of the following:  
 
1. The URL is any IP address, for example “http://123.456.789.123/” (Version 8 Only) 
2. The URL is a Local Area Network server or computer name, for example “http://servername/” or 
“http://computername/” or “http://localhost/” 
 
NOTE: You may also want to turn on the “Store Closed” mode, so that that shop pages are not visible.  Go 
to “Settings” then click “Checkout” to adjust the shop Access settings. 
 
If you want to change or remove the “Powered by PDshop” messages that appear in the shop, see the  
“Branding Developer/Reseller” settings section in this Guide. 
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Editing the "web.config" Keys 
  
  
Once you determine what type of database you will be using and where it located, or what driver you wish 
to use, enter the appropriate connection string, database & driver types into the "appSettings" section of 
your web.config file.   
 
Below are examples of how you should format the application-wide constants. The keys below should be 
added to the <appSettings> section of your web.config file.  You can only have one database connection 
in your web.config file, if you use the default web.config file be sure to comment out (or remove) the 
default database connection. 
 
 
NOTE: the "system.web" section of the web.config should not be changed.  It must contain the following: 
 
<customErrors mode="Off"/> 
<httpRuntime executionTimeout="90"/> 
<compilation defaultLanguage="VB" debug="false" /> 
<pages buffer="true" enableViewState="true" enableSessionState="false" autoEventWireup="true" /> 
 

Microsoft Access Database OLEDB Driver  (Default - Recommended) 
 
Use: 
<add key="dbvirtualpath" value="/data/somefile.mdb" /> 
 
OR Use: 
 
<add key="dbphysicalpath" value="C:\inetpub\wwwroot\data\somefile.mdb" /> 
 
OR Use: 
 
<add key="dbtype" value="MSACCESS" /> 
<add key="dbconntype" value="OLEDB" /> 
<add key="dbconn" value="Provider=Microsoft.Jet.OLEDB.4.0; Data 
Source=C:\inetpub\wwwroot\data\somefile.mdb" /> 
 
 

Microsoft Access Database with ODBC Driver 
 
<add key="dbtype" value="MSACCESS" /> 
<add key="dbconntype" value="ODBC" /> 
<add key="dbconn" value="Driver={Microsoft Access Driver (*.mdb)}; 
DBQ=C:\inetpub\wwwroot\data\somefile.mdb" /> 
 

Microsoft Access DSN via an ODBC Driver 
 
<add key="dbtype" value="MSACCESS" /> 
<add key="dbconntype" value="ODBC" /> 
<add key="dbconn" value="DSN=yourdsn;Uid=youruserid;Pwd=password;" /> 
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Microsoft SQL Server Database via SQL Client Connector (Recommended for 
MSSQL) 
 
<add key="dbtype" value="MSSQL" /> 
<add key="dbconntype" value="SQL" /> 
<add key="dbconn" value="SERVER=servername;UID=youruserid;PWD=password;Initial 
Catalog=databasename" /> 

Microsoft SQL Express via SQL Client Connector (Recommended for MSSQL 
Express) 
 
<add key="dbtype" value="MSSQL" /> 
<add key="dbconntype" value="SQL" /> 
<add key="dbconn" 
value="Server=localhost\SQLEXPRESS;Database=databasename;Uid=youruserid;Pwd=password;"/> 
 
** Please note you may need to substitute “SQLEXPRESS” with your MSSQL instance name, contact the 
server administrator if you are not sure.  If the SQL Server is not installed locally, you will also need to 
change “localhost” to the remote server’s name/ip address. 
 

Microsoft SQL Server Database with OLEDB Driver 
 
<add key="dbtype" value="MSSQL" /> 
<add key="dbconntype" value="OLEDB" /> 
<add key="dbconn" value="Provider=SQLOLEDB;Data Source=servername;Initial Catalog=database;User 
Id=sa;Password=password;" /> 
 

Microsoft SQL Server Database with ODBC Driver 
 
<add key="dbtype" value="MSSQL" /> 
<add key="dbconntype" value="ODBC" /> 
<add key="dbconn" value="DRIVER={SQL 
Server};SERVER=servername;UID=sa;PWD=password;DATABASE=database" /> 
 

MySQL Database with MyODBC Driver (NOT SUPPORTED) 
 
<add key="dbtype" value="MYSQL" /> 
<add key="dbconntype" value="ODBC" /> 
<add key="dbconn" value="Driver={MySQL ODBC 3.51 
Driver};Server=localhost;Option=3;Database=database;User=userid;Password=password" /> 
 
MySQL Notice: MySQL is not the same as MSSQL.  MySQL is an open source (free) database system, 
whereas MSSQL is built by Microsoft specifically for Windows servers.  Because there are many different 
versions of MySQL, and there are known bugs (problems) with many versions of MySQL, PageDown 
Technology cannot provide any guarantee or support if you choose to use PDshop with MySQL.  We 
strongly recommend that you use MSSQL (Microsoft's SQL Server), it is more robust, proven reliable, and 
supported.   
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Branding Developer/Reseller Settings 

Branding Mode 

 
In PDshop version 8, you can override our branding (the “Powered by” messages), and substitute your 
own, or remove them altogether.  Using these special web.config Keys below. 
 
<add key="devbrand" value="ON" /> 
<add key="devshoplogourl" value="http://your website name.com/images/logo.gif" /> 
<add key="devadminlogourl" value="http://your website name.com/images/logo.gif" />     
<add key="devshoptext" value="Powered by Your Company, Inc" /> 
<add key="devadmintext" value="Powered by Your Company, Inc" /> 
<add key="devurl" value="http://your website name.com/" /> 
 

Other Settings 

Encryption Password 

Enter an encryption password, used to encrypt Credit Card Numbers and User Passwords 
Remove Value if you do not wish to use encryption 
 
<add key="cryptpass" value="password" /> 
 
If you are upgrading from a “Classic ASP” version, you should put your rc4code password in the value.   
 
For example, if your setup.asp file had this: 
rc4code=”123456” 
 
Than your web.config must have this: 
<add key="cryptpass" value="123456" /> 
 
Enforce Secure Admin Connection 
Some versions of PDshop allow you to force a secure connection to the Administrator.  When enabled, you 
will only be able to login to your Administrator if you are connecting using an SSL (Secure Url), for 
example:  “https://yoursite.com/admin”  
 
Your web.config must contain this: 
<add key="enforceadminssl" value="ON" /> 
 

Error Handling 

Enter a Text message that will display when a PDshop error occurs. This will override PDshop's Error 
handling and prevent you from troubleshooting, but can provide an additional layer of security (as error 
messages can be exploited by hackers). 
 
<add key="pdshoperrormessage" value="We're sorry, an error has occurred. This page is not available." 
/> 
 

Admin Folder 

 
<add key="pdadminfolder" value="admin" /> 
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Demo Mode 

 
<add key="demomode" value="OFF" /> 
 

Culture/Globalization (optional, not recommended) 

Enter an ASP.NET culture if you want to override the default culture/globalization setting set by your web 
server and PDshop.  If you wish to disable PDshop’s culture functions altogether (which may be required 
to resolve some formatting errors), enter “auto”.  We do not recommend changes to the culture, by 
design you should be able to display numbers, currency, and dates in any region by using the option 
available in PDAdmin, see the “Formatting” setup page. 
 
<add key="pdshopculture" value="en-US" /> 
 
 
If you receive a "Missing Key Exception" error when trying your shop for the first time, than you have an 
error in your web.config.  
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Troubleshooting  (PDshop .Net Errors) 
  

Upgrading or Installing an Update? 
The most common mistakes when upgrading or installing an update are: 
 
1. Not uploading all of the .aspx scripts in the zip file you downloaded.  You should not mix & match script 
versions, when uploading be sure to overwrite all scripts on your web server with the new ones.   
2. Not running any required database procedures, in most cases you will need to run the "Format/Upgrade 
Database" procedure (which upgrades your database tables & columns) 
 
Make sure you following the correct Installation Guide.  
  

Below are some common Error Messages & Solutions: 

 

Compilation Error:  Type 'PDshopNetFunctions' is not defined 
This error usually indicates that you did upload the "Bin" folder to your web server, you did not upload it 
to your application/web "root", or the .dll files that belong in the folder are missing.  Microsoft web servers 
require that you place your Bin folder (and it's DLL files) at the root of your web/application.  For example, 
the top directory of your website, so they would be located at "yoursite.com/bin".  Check the location of 
the PDshop .Net bin folder, make sure it contains the PDshopNet.dll file. 
 

web.config Exception: Missing Key 
The above error can occur if you have made an error while editing the web.config file.  Go back over the 
Installation guides, you may not have provided enough information in the web.config file to establish a 
connection to your database.  
 

dbconn.open Exception: [some path or folders] is not a valid path  
Make sure that the path name is spelled correctly and that you are connected to the server on which the 
file resides 
The above error can occur if you have made an error while editing the web.config file.  The path you 
specified to your database (see the dbvirtualpath & dbphysicalpath keys) contain the wrong path or you 
have more than one path specified (if you added a key, you may not have commented or the old one). 
 

SaveData Exception: Operation must use an updateable query 
This error usually indicates that you did not set the appropriate permissions on the database, 
"somefile.mdb". You will need to change the security settings (a.k.a. permissions) on the web server on 
your database directory. 
 

Using a hosting service? 

Contact your web hosting service and request that they set your database permissions, or follow the 
instructions they provide for setting permissions.  
 

Running your own server? 

The security account used by the web server IIS service should have at least "Write" permissions on the 
database file (Note: You cannot set the permissions from within IIS, see below). To adjust the file 
permissions, you need to locate the file (will look like: "somefile.mdb") by using "My computer". Right 
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click on the file, click on "Properties". Next, click on "Security". There are several user/system accounts 
listed, you'll need to modify the permissions for the account that the IIS web service uses (if you don't 
know, you can always add the user "Everyone" and give it "Full Control"). NOTE: You cannot use the IIS 
console to change the file permissions, the Access settings in the IIS console are not the same as "File 
Permissions". The settings in IIS only control what web browsers/internet users have access to (not file 
security). 
 

OpenDataReader Exception: No value given for one or more required parameters 
 
Messages similar to this usually indicate that you did not run the database "Format/Upgrade" procedure, 
as described in the Installation or Upgrading Instructions.  Using your web browser, un the database 
format/upgrade procedure, which will add any new tables, columns (fields) to your database.  Using your 
web browser, navigate to the "dbsetup.aspx" page in your "admin" directory on your server.  For 
example: http://www.yourdomainname.com/admin/dbsetup.aspx.   
(replace "admin" in this URL with the name of your admin folder) 
 

OpenDataReader Exception: The Microsoft Jet database engine cannot find the 
input table or query 'setup'  
 
Messages similar to this usually indicate that you did not run the database "Format/Upgrade" procedure, 
as described in the Installation or Upgrading Instructions.  Using your web browser, un the database 
format/upgrade procedure, which will add any new tables, columns (fields) to your database.  Using your 
web browser, navigate to the "dbsetup.aspx" page in your "admin" directory on your server.  For 
example: http://www.yourdomainname.com/admin/dbsetup.aspx.   
(replace "admin" in this URL with the name of your admin folder) 
 

Object reference not set to an instance of an object 
This message can mean there is a very basic installation problem, you may have missed an important 
step, you should go back over the Installation guides again from the beginning.  This may be an issue with 
your web.config file (it may be missing some basic information, such as the "system.web" keys), or some 
other issue related to how/where you uploaded the PDshop .Net files. 
 

Browser Related Problems 
If you experience problems client side, with your browser, see Browser Troubleshooting. 
 
More Help 
For additional help, see our Knowledgebase at www.pagedowntech.com/faq. 
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Troubleshooting (Browser Problems) 
  
 If you experience problems with your browser while working with PDAdmin or PDshopPro, you may need 
to perform some routine housekeeping tasks as described below.   

Common Problems 
Pop-Up windows do not open. 
HTML / Content Editor does not work correctly. 
JavaScript Errors. 
Shopping cart contents do not appear to save. 
 

Common Causes 
Some of the common client side problems are due to the following: 
 
1. A corrupt browser cache (temporary internet files/cookies). 
2. Internet Explorer Add-Ons are blocking some JavaScript or Iframe functions. 
3. Incorrect Internet Explorer security settings. 
4. 3rd party security, Privacy, Firewall, or other Internet related software. 
5. JavaScript (a.k.a. Active Scripting) is disabled. 
6. Cookies are disabled or being intercepted/blocked by security/privacy software. 
 
Most issues can be resolved by following all of the steps outlined below: 
 

Delete “Cookies” 

Internet Explorer (version 5) 

1. On the Tools menu, click Internet Options, and then click the General tab.  
2. In the Temporary Internet Files section, click Settings.  
3. Click View Files.  
4. On the View menu, click Details.  
5. Click the Internet Address column header, and then find the Internet addresses of the cookie files. 

For example, a cookie Internet address may be named similar to the following name: 
Cookie:username@websitename.com  

6. Click a cookie file, and then press DELETE. If you are prompted to confirm that you want to delete 
the file, click Yes. Repeat this step for each cookie file.  

Internet Explorer (version 6) 

1. On the Tools menu, click Internet Options, and then click the General tab.  
2. In the Temporary Internet Files section, click Delete Cookies, click OK, and then click OK again.  

 

Internet Explorer (version 7) 

1. Open IE, click on Tools 
2. Click on Delete Browsing History 
3. Press the Delete Cookies button. 

 

Delete Temporary Internet Files 

Internet Explorer (version 5) 

1. Open IE and click on Tools 
2. Click on Internet Options 
3. On the General Tab, in the middle of the screen, click on Delete Files 
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4. You may also want to check the box "Delete all offline content" 
5. Click on OK and wait for the hourglass icon to stop after it deletes the temporary internet files 

Internet Explorer (version 6) 

1. Open IE and click on Tools 
2. Click on Internet Options 
3. On the General Tab, in the middle of the screen, click on Delete Files 
4. You may also want to check the box "Delete all offline content" 
5. Click on OK and wait for the hourglass icon to stop after it deletes the temporary internet files 

Internet Explorer (version 7) 

1. Open IE, click on Tools 
2. Click on Delete Browsing History 
3. Press the Delete Files button. 

 

Disable Browser “Add-Ons” 

Internet Explorer (version 5) 

1. Close all instances of IE, click Start, point to Settings, and then click Control Panel.  
2. Double-click Internet Options.  
3. Click the Advanced tab.  
4. Under Browsing, click to clear the Enable third-party browser extensions (requires restart) check 

box.  
5. Restart IE.  

Internet Explorer (version 6) 

1. While IE is open, go to Tools > Internet Options > Programs Tab > Manage Add-ons.  
2. Disable any 3rd party Add-On that may be interfering with normal operation. You may need to 

restart the browser for the changes to take affect. 

Internet Explorer (version 7) 

1. While IE is open, go to Tools > Manage Add-ons.  
2. Disable any 3rd party Add-On that may be interfering with normal operation. You may need to 

restart the browser for the changes to take affect. 
 

Delete browsing “History” 

Internet Explorer (version 5) 

1. Open IE and click on Tools 
2. Click on Internet Options 
3. On the General Tab, in the middle of the screen, click on Clear History 
4. Click OK 

Internet Explorer (version 6) 

1. Open IE and click on Tools 
2. Click on Internet Options 
3. On the General Tab, in the middle of the screen, click on Clear History 
4. Click OK 

 

Internet Explorer (version 7) 

1. Open IE, click on Tools 
2. Click on Delete Browsing History 
3. Press the Delete History button. 
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Reset all Internet Explorer Security & Privacy Settings 
Reset ALL Security & Privacy settings to their original settings; use the set to "defaults" buttons where 
possible.  Most browser related problems can be resolved by returning your settings to their defaults. 
 

Disable 3rd party software 
Turn off script filters/blocking, Pop-UP/Virus/Firewall software, or any other internet related software. 
Norton's Script Blocking Service, Norton's Internet Security software, and Zone Labs Zone Alarm Security 
software, are among many, that if not configured correctly, can interfere with or block some basic 
JavaScript & "Iframe" functions (which are an integral part IE) 
 

Update Internet Explorer (Go to Windows Update) 
Make sure you have updated IE with all the latest patches & service packs from Microsoft. Go to "Windows 
Update" and download and install the latest IE Service Pack.  
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Top Security Tips (Best Practices) 
  
   

1. Periodically check that your database is properly protected against 
unauthorized access.  
If you installed PDshop with the default Microsoft Access database, make sure it is impossible for someone 
(other than you) to download/access your database file. Your database directory should be configured with 
special permissions (a.k.a. Security) in such a way that PDshop & PDAdmin can read/write to the 
database, but no one else can see or download it. We recommend that your database be kept in a special 
directory that is only accessible by FTP. Consult with your web host or server administrator for their 
procedures and suggestions for securing database directories.  
 
IMPORTANT: We strongly recommend that you rename your database file.  You should use a unique name 
that only you would know.  For example, do not leave your database with a name like "pdshoppro.mdb".  
You will need to update your setup.asp (or web.config) file accordingly.   
 

2. Rename your "admin" and "data" directories to help protect against 
unauthorized access.  
Since these directory names are common knowledge, as an added level of security we suggest that you 
rename these directories to something only you would know.  You will need to update your setup.asp (or 
web.config) file accordingly.   
 

3. Change your passwords often, and do not use the same username/password 
combinations more than once.  
Change your password at regular intervals and make sure your PDAdmin username/password is not the 
same as your FTP, hosting account, or server control panel logins. This can be devastating if your 
password is ever found or discovered thru some of the various hacking techniques.  
 

4. Make sure your web host/server admin has properly protected your web 
server.  
A web server with poor firewall protection, or insufficient settings, or an "unpatched" operating system, 
can make your website vulnerable to many internet threats, including unauthorized access, malicious 
attacks, and virus infection.  
 

5. Download and Install the latest revision of PDshop periodically.  
Our developers are always improving how PDshop works, for this reason revisions to each edition of 
PDshop are released from time to time. These revisions/updates are full versions that often contain 
improvements, bug fixes, critical security updates, and even new features. To download the latest 
revision, login to your account and click 'Your Downloads'. See the Upgrading & Installation Guides for 
help with installation or upgrading procedures.  If you need assistance with installing these 
revisions/updates, contact PageDown Technology. NOTE: If you are using a customized version of PDshop 
or made your own script changes, consult with your web developer or PageDown Tech. before installing 
any revisions. 
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6. Enable all 'Recommended Security Settings' in PDAdmin. 
Since you may be hosting PDshop on a public or shared web server, as a general precaution, we do not 
recommend storing sensitive credit card information in your PDshop database.  If you are processing 
credit cards, you should do so thru one of the payment gateways that PDshop supports.  When processing 
thru the supported payment gateways, PDshop does not need to store any credit card information, it is 
securely passed to the payment gateway's own system for processing.  Storing credit card data on your 
own web site can put your customer's information at higher risk.  See PDAdmin 'Help' for more 
information on these settings. 
 
Special Notes:   
If your copy of PDshop was installed by a 3rd party, or by PageDown Technology, you may need to 
contact the person or company who handled your installation, or order the "Installation Service" from 
PageDown Technology.  To order our Installation Service, please login to your account.  Click on "My 
Account" from anywhere on the PageDown Technology website. 
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Terms & Conditions 
 
This guide is intended for licensed users of PDshop only.   
 
See the Terms & Conditions for PDshop on the PageDown Technology website, see 
http://www.pagedowntech.com/terms. 
 
Additional Support and Information about this product can be found on PageDown Technology’s website, 
http://www.pagedowntech.com. 
 
Copyright Notice:  
All Text and Images contained on this document is the property of PageDown Technology, LLC 
(pagedowntech.com) and cannot be reproduced, copied, or used without our written permission.   
 
PageDown Technology, LLC / Copyright 2003-2010 All Rights Reserved   
 


